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February 2013 BMUG PRESENTATION
President Peter outlined details for the March 2nd Photo day. This
was followed by a presentation from Dick Brown on “Good
Photography Techniques”, using slides from his working career.
David Dixon presented an overview of iMovie, with a view to
starting a SIG Group which would meet outside of the normal BMUG
Meeting time.

BMUG Newsletter Masthead &
Layout
Designed by Peter Baldwin.

BMUG Newsletter is published
monthly. It is produced using
Apple Pages and converted to
PDF Format for transmission
to members.
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COMMITTEE
President & BMUG Assist.
Peter Oakley
peteroakley@bellarinemac.org.au

Vice President, Editor &
Web Assist.
Peter Baldwin
peterbaldwin@bellarinemac.org.au

Secretary & Membership.
Positions Vacant.
Volunteers Required.
Treasurer.
Ian Little

Your committee have taken the theme for the
start of the 2013 membership year of “Back to
Basics”. There will be more on this in the
forthcoming program meeting notes.
Past President David Dixon gave an overview
of iMovie’11 at the February meeting, with the
aim of starting a SIG (Special Interest Group)
to meet outside of the normal general meeting
time. We look forward to seeing the results of
this SIG membership, perhaps at the
December meeting. There’s a challenge for all
of you in the SIG.
Just a reminder on some other SIG’s we can
offer.

Our Genealogy group is slightly different in
that we “meet” via email. If you wish to be
included please contact a committee member.
The irregular iPad sessions held on a general
meeting day could be uprated to a SIG with
meetings outside those of the normal second
Tuesday of each month. If you are interested
in this arrangement please add your name to
the list available at the Sign-In desk at this
meeting. At the moment this is just to get an
idea of the numbers who would like to attend.
Cheers for now.

ianlittle@bellarinemac.org.au

Hall & Equipment,
New to Mac Advisor.
Margaret Evans
margaretevans@bellarinemac.org.au

Meet, Greet &
Secretary Assist.
Bev Amey
bevamey@bellarinemac.org.au

Committee Member.
Position Vacant.

The Garageband (SIG) is available on a one to
one basis run by Brian Riggs at his home.
Please contact me on (mbl 040909 4655) to
arrange a date/time with Brian.

Peter Oakley

Mac Tip For Mountain Lion: ZOOM IN.
Zooming in on your display screen in order to better read something can be done in a number of ways. I have
found that the easiest way for me is to use a gesture. I do a 2-finger scroll up while pressing the Control Key. To
zoom out, I scroll down while pressing the Control Key.

How to set this up:
Go to System Preferences, Accessibility, click the Zoom tab in the sidebar, and click the modifier key you want to
use when zooming. It's the second item on the right-hand side. You can also select the Zoom Style as “full
screen” or a rectangular enlargement, which is termed “picture-in- picture”.
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If any member has
expertise in any topic
and would like to
volunteer to assist
with
running
a
session,
your
Committee would
appreciate an offer.

Proposed iMovie SIG Group
At
the
last
meeting
approximately 9 members
indicated that they would
like to participate in an
iMovie SIG.
In order to assess the interest and
plan for the SIG, it is proposed that a BBQ
lunch will be held at the residence of SIG
Convenor, David Dixon, on Saturday 16th
March, commencing at 12Noon and
concluding
at
approximately
3pm.
Participants to bring their own meat and
drinks and David will provide the salads.
Further details will be announced at this
meeting.

Are you interested in an iPad SIG?
If you are interested in
participating in an iPad SIG
please add your name to the
list available at the Sign-In
desk at this meeting. At the
moment this is just to get an
idea of the numbers who would like to
participate.

Membership Reminder 2013
Membership Subscriptions
for 2013 are now Overdue.
Our membership financial year
begins in January and continues
until December each year.
Single Membership: $40.00;
Couple Membership: $70.00;

Lucky Door Prize at this Meeting
This month the lucky door
prize is a one month macPro
Video “Core Library Pass”,
kindly provided by macPro
Video.com and valued at
$25 USD. This pass
will
give you
instant
access to
the macPro Video Online
Tutorial Library for a period
of one month from when
you activate it.

Remote Membership: $25.00;
Student Membership: $25.00.
Payment
follows:

can

be

made

as

• At this March meeting;
• By mail to the Treasurer, 25
Catalina Cres., Clifton Springs,
3222;
• Through PayPal via the BMUG
website.

Unless you renew your
Membership, this will be
your last BMUG Newsletter.
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Computing History
June 1, 1890: the Census Bureau Can Finally Keep Tabs on
a Growing Nation
The basis of the computer was invented for use in the census? Yes.
It was all the brainchild of Herman Hollerith, a New York statistician.
He invented the device for the U.S. Census Bureau for use in the
1890 census. That is the census that was later destroyed by a fire
and by the water used to quench the fire.
Determining the results of the 1880 census proved to be a
monumental task, requiring eight years to complete. The Census
Bureau knew that there had to be a better way and asked for bids
from companies to improve the process.
Hollerith invented a tabulating machine to quickly count information
that had been entered on punched cards that were the size of an
American dollar bill at that time. (The dollar bill was later reduced in
size but the so-called Hollerith cards remained at 3.25 by 7.375

capable of reading whether or not a hole
had been punched. An electric contact
was made when a hole was recognised,
which rang a bell and sent the data to a
counter. The 1890 tabulator was
capable only of counting.
Subsequent models, developed by
Hollerith himself, were also able to add,
which made the machines useful for
accounting, warehousing, and shipping
applications. Between 1902 and 1905,
Hollerith also developed an automatic
card feed and a method for reading
cards in motion and settled on a
standard
card
format.

The 1890 census tallied 63 million
people. (The most recent count, in
2010, reached nearly 309 million.)
This Article is provided courtesy of
Dick Eastman’s Online Genealogy
Newsletter
http://blog.eogn.com/

inches.)
On
January
8,
1889, Hollerith was
issued U.S. Patent
395,782.
Data for
H o l l e r
invention
counted
machine
employed
loaded

Herman
i t h ' s
was
by
a
that
springneedles

founded a company to build more
tabulating equipment, called the
Tabulating Machine Company. In
1911 four corporations, including
Hollerith's firm, merged to form the
Computing Tabulating Recording
Corporation. It was renamed in 1924
to International Business Machines
Corporation (IBM).

eastmans_online_genealogy/

Editor’s Note:

Punch cards remained popular in
computers through the 1970s. Hollerith
also remained successful when he

In the early 1970’s, I was involved in
the development of Accounting
Systems
for
“Visible
Record
Computers” that used decks of Punch
cards for each Program. The cards
were fed into a hopper to commence
a Program.
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Member Contribution
A Different Use for an iMac
Story by member Jim Strachan
Recently a family member asked me to record
an episode of Downton Abbey. Naturally I
agreed to this request but my normal means of
recording was through the Foxtel system and
unfortunately I was already recording two
programmes which overlapped that requested.
What do I do?
A couple of years
ago
a
gadget
called “The Tube”
was written up in
the Green Guide
of The Age and I
purchased
it.
The
device
consists
of
a
small unit about
the same size as a memory stick which
connects a TV antenna cable to a USB port on
the iMac. With this it becomes possible to play
HD and other TV programmes on one’s
computer. As would be expected a very clear,
full colour picture is obtained. There is also
the facility to record programmes by simply
clicking on the programme guide. Through

AirPlay it then becomes possible to show the
recording on Apple TV.
The Tube replaced an old small screen
analogue TV with the latest HD picture on my
computer. All this for about $100.
Having done all this I was left with Downton
Abbey on my iMac waiting to be viewed. As
usual with a commercial channel there were
almost the same length of commercials in the
recording as the actual programme so I
transferred all to iMovie, creating a new
project. It was then simple to delete the
frames
containing
commercials
thus
shortening the entire recording by some 20
minutes.
What next - from the ‘Share’ dropdown menu I
selected iDVD and headed for a cup of coffee
whilst things sorted themselves out. After
about 15 minutes I was able to burn the edited
programme to a DVD for use by my family.
The entire process took a little time but there
was no need to be sitting watching the
computer doing its thing behind the scenes.

BMUG Tip of the Month
Adapt the OS X Menu Bar to Meet
Your Needs
The right end of the OS X menu bar
at the top of the screen can display
any combination of icons. In many
instances, these icons are menus that
offer access to system or application
features. A typical collection of menu
bar icons includes Time Machine,
Bluetooth, Wi-Fi, Sound, Battery
Level, Date & Time, User Name,
Spotlight
and
Notifications.
In
addition to showing or hiding these
icons
with
various
System
Preferences
options,
you
can
rearrange many of the icons to suit
your needs. Just hold down the
Command Key and drag an icon to
the desired position on the end of
the menu bar. When you release the
mouse button, the icon moves to its
new position. Dragging a menu bar
icon off the menu is a quick way to
remove it without opening System
Preferences or the application that
put it there.

Jim Strachan
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Note: You cannot move

the Spotlight or Notifications icon or
move any other icon to their right.
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iPad For Dummies,
5th Edition

contacts, and using your iPad as a personal
hotspot.

The book covers getting started with your
iPad mini, mastering the multitouch
Book Retail Price $29.95
interface, synchronising your data,
If you want to get
working in the iCloud, setting up iTunes
the very most out of
and your iPad mini, browsing the
your iPad, this is the
Internet, sending and receiving e-mail,
book for you. It
guides you through
texting with iMessage, browsing and
the iPad basics before
downloading applications from the App
moving on to the latest features including
Store,
making
video
calls
with
Siri, Passbook, Facebook integration, a
FaceTime,
working
with
Siri
your
voice
Members can purchase these books from
brand new Maps app, and enhancements
activated virtual assistant, unveiling the
Wiley Publishers at a 30% discount plus
to your favourite features like FaceTime,
iPod in your iPad mini, taking control of
$7.50
postage.
Promo
Code:
OSX12
Safari, Mail, Photos, and so much more.
your tunes, finding and watching
www.wiley.com
videos,
importing
pictures
and
The book Covers the third-generation
launching slideshows, capturing photos
iPad, iPad 2 and original iPad and is fully
and videos, curling up with a good
updated for iOS 6.
iBook,
getting
organised
with
It gets you up to speed on the multitouch
Reminders, finding your way with maps,
interface, setting up your e-mail account,
working with the calendar, sharing photo
getting connected, filling your iPad with amazing
streams, taking notes, adding and viewing
apps and cool content, and more
contacts, staying connected with Notification
It shows you how to do lots of things, including
iPad mini For
Center,
protecting
your
information,
how to order around your Siri virtual personal
Dummies
accessorising
your
iPad
mini,
assistant, make video calls with FaceTime, unveil
The Information in this
troubleshooting, and more.
the iPod in your iPad, curl up with a good iBook,
book is presented in the
Book Retail Price $29.95.
and get organised with Reminders
straightforward but fun
Some Discounted Books will be available
It includes tips on protecting your information,
at this meeting.
language
that
has
defined
the
Dummies
troubleshooting, connecting wirelessly, adding
Book Reviews by Peter Baldwin
series for many years.

Books From Wiley Publishers
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Products from Cygnett
Cygnett has kindly provided our Group with several of their excellent iPhone and iPad Mini cases for Review and promotion
in this Newsletter and also to use as Prizes or other incentives to members. Below is a sample of some of the products we
will feature as future prizes to members. KEEP READING FUTURE NEWSLETTERS FOR DETAILS OF HOW TO WIN A PRIZE.

iPhone 4S Glam Patent leather case
Purple
Padded patent leather case
for iPhone 4 & 4S!
Microsuede interior & credit
card pocket
Flip down design for easy
access.
Full access to iPhone screen,
buttons, camera, charging &
syncing function. Hidden magnetic clasp.
Includes screen protector to guard against
scratches, smudges & dust. Microfibre
cleaning cloth — keeps your iPhone shiny &
new 2 year manufacturer's warranty.

iPhone 4S and iPhone 4 Urban Shield
brushed
aluminium
case Gold

Precision-machined
from
premium-grade
brushed
aluminium.
Ultra-slimline,
close-fitting
profile
with
rubber-finish
corners.
Superb
detailing,
with
bevelled edges. Easy access to

all ports, controls & connectors. Includes screen
protector & microfibre cleaning cloth that guard
against scratches & dust. http://au.cygnett.com/
urban-shield-4.html

Cygnett ICON Ronnie Tjampitjinpa
Case for iPhone 5 Echidna Dreaming
Smooth yet durable, this case
with an anti-fingerprint finish
offers
excellent
surface
protection from fingerprints,
dirt, skin oil, sweat and
cosmetics.
Super-slim shield that protects edges and
corners. Grips in your hand yet slides easily into
your pocket. Highly durable polycarbonate
material. Flexible, slimline snap-on design
protects the edges & corners of your iPhone
without adding bulk. Includes screen protector.
Artwork steeped in Aboriginal dreamtime adorns
this hard, slim case.
Designed exclusively for the iPhone 5, the Icon
cases are a series of designer hard cases.

iPhone 5 Workmate Shock absorbing
case
WorkMate combines a heavy
duty shell and impact resistant
inner to defend your iPhone at
work or play. The slim fit, dual
material case is extra protective
and
pocket-friendly.
Enjoy
access to all functions and screen protector.

iPhone 5 Urban Shield Genuine Cabon
Fiber Case
Make a statement with the
genuine carbon fiber, super
strong UrbanShield for your
iPhone. Precision-machined,
slim and high performance, it
protects against scratches
and allows access to all controls. Includes a
screen protector.

7
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Cygnett Enigma iPad Mini Flexi-Folding
Folio Case - Pink
The New Enigma for iPad Mini from Cygnett features a clever folding cover design to
reveal flexible viewing positions. Featuring a secure snap on case, a soft, rubberised cover
and microfiber inner to protect the screen from scratches, you’ll enjoy easy access to all
functions.
For more information on Cygnett Products click on the link belowwww.cygnett.com

Cygnett has become one of the
world’s leading digital accessory
designers and manufacturers and,
this year, will celebrate their 10th
birthday. Their cases for Apple
tablets, speakers, headphones, power and screen
protectors can be found in 50 countries and more
than 55,000 retail outlets.
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Using VIPs To Sort Mail
If you regularly need to
view a certain person’s
messages all in one
place, Mountain Lion’s
Mail program now has a
new
filtering
system
called VIPs. Adding someone as a VIP means that
everything that person sends you will be put into a
separate Smart Mailbox for easy viewing. It does
not include the emails that you send to that
person.
It is very simple to set up. Just hover over the
person’s name in the sender field of one of their
emails, and a little star will appear.

bring one up with an option for adding him or her.

Apple Mail & Mountain Lion
Note: If the person in question is in your
Contacts, any additional email addresses you have
in there for them will also apply to the VIP
filtering. So you don’t have to go in and add the
additional email addresses for that person.
When you get a new email from a VIP, the little
star next to their name will light up (replacing the
traditional blue dot).
It is very easy to remove a VIP. To do so, right- or
Control-click on their name in your VIPs list and
choose Remove from VIPs.

Click the star and your new VIP mailbox will be
created, and all of the messages received from
that
person
will
show
up
in
there.

If you prefer contextual menus, another way to do
the same thing is to click on the drop-down arrow
next to a sender’s name (or email address) to

Editors Note:
I have found this VIP facility useful when I’m
working on projects with others. Mark them as
VIPs temporarily, then remove them when you’re
done. It is much faster than setting up a Smart
Mailbox, or constantly having to search.

Remove multiple people from your VIPs list by
holding down the Command key and clicking to
select each of them, and then right-click on the
list as above.

How to show the text underneath
an Icon:
Ctrl+Click OR Right Click next to an
Icon and select “Icon & Text” from
menu.
Customise Toolbar and add Format Icon
Open a New Message in Mail and Click
“View>Customise Toolbar”, then drag the
Format
Font
on
to
the
Toolbar.

Click the Format button to access options for
formatting text in the email.
Attachments
If you are forwarding an email with an
attachment then that attachment is included. If
you reply to an email the attachment will not be
included.
Entering Name of Recipient
When entering the name of a recipient for a
message, Mail will display details of matching
names from your contacts.
9
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How to print selected pages from a website
or a multi page Document

just simply hit the “Print” button. Click
on a Thumbnail to view the contents of
a page.

You can make the Thumbnail Pages
Column wider by clicking on the right
hand side of the column and dragging
to the right.

1. Open the website or document that you want to print from, with
the Page Thumbnails showing.
To open your Page Thumbnails, click on View>Page Thumbnails.
2. Click on “File>Print>Open in PDF Preview.
3. A Preview Panel opens with all the Thumbnails shown (either on
the Right or Left Hand side), that would have been printed had you

4. In the Preview Window of this
example above Page 1 is highlighted.
If you only want to print Page 1 then
you have two options(a) Click the “Hide Details/Show Details”
Button, so that the “Show Details”
screen is open and select “Pages-Single”
and then highlight Number 1.
A picture of that page will be shown and
then click Print.

(b) Click the “Hide Details/Show
Details” Button, so that the “Hide
Details” screen is open and click
Pages from 1 to 1, then print.
Alternatively, if you want to print, in
this case, the 3 pages, you have the
“Hide Details” page open and click
“Pages All” and then click print.

Peter Baldwin
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Plea from Remote Member Marg Boyles
In May, 2006, I could not believe my eyes when I saw an
advertisement in The Ocean Grove Echo advising that there was
interest in setting up a Mac User Group. Although I was reasonably
confident doing the things I wanted to do with my Mac, my
abilities were quite limited and I was excited at the prospect of
improving my knowledge. They were the days before I was taught
by BMUG to do something as simple as a Google Search when I
encountered any problems. So off I went to the first ever meeting
of the Club that was to become the Bellarine Mac User Group.
I had never been a person to join committees but I was excited
about being able to attend a club in my home town that may give
me the chance to advance my knowledge. I decided then and there
to volunteer to help set up the club. I became a member of the
original Steering Committee and progressed to become a full
Committee Member and served in that position for four years until
my husband and I moved back to Melbourne to a Retirement Village
in May, 2010 when I had to resign as a Committee Member. I would
still be involved with the BMUG Committee if I had not moved from
the area.
I am now a Remote Member of BMUG and value my membership. I
have constant email or phone contact with some of the Committee
Members, asking questions, sharing ideas with my fellow
enthusiastic Mac Users.
I look forward to receiving and reading the monthly Newsletter, an
excellent production created every month by Peter Baldwin. I query
if any member has ever wondered how much time Peter devotes to
BMUG preparing this Newsletter along with the many other tasks he
undertakes.
Do you ever give thought to the time all of your very able
Committee members spend to make sure that BMUG continues for

your benefit? Think back to before you
joined BMUG. What would you have
rated your knowledge base then
compared to now, having been a
member of BMUG for however long?
Think about where you would go for
help when your next problem arises or
if you would like to learn something
new. Is there anywhere that you could
go for unpaid help to solve a problem?
Another Mac user group is situated on
the Surf Coast, or there is AUSOM in
Melbourne. Too far to go for Bellarine
residents. In Geelong there are only
retail Mac shops. Many years ago,
before BMUG, “Computers Now” did run
some classes. I went to classes on
iMovie and iDVD and had to pay $75.00
for a two hour session which was not
hands on. You can learn the same
things at BMUG for only a very
reasonable annual fee. As well as the
Committee Members, there is bound to
be another BMUG member who is willing
to share their knowledge of a particular
aspect of Mac use with you. After all,
BMUG is an enthusiastic band of Mac
users coming together to share
knowledge.
What would YOU do without BMUG?
Spare a few moments to ponder that
statement.

The monthly meetings that you all
obviously enjoy, confirmed by the
regular attendance of so many of
you, do not happen by themselves.
They happen because a small band
of your fellow club members
volunteer their time to firstly plan
and then bring you these meetings.
As well as the monthly BMUG
meetings, there are also the
fortnightly Green Apples meetings
ably run by Dick Brown, another of
your fellow BMUG members. Where
else could you have questions
answered
with
such
individual
attention.
Please
seriously
consider
volunteering your time to ensure
that BMUG continues into the
future. Try volunteering for one year
as a start. You may find, like I did
that it was very beneficial not only
for the future of BMUG but also
personally to yourself.
Finally, please please consider what
you will do if BMUG folds because of
lack of members willing to put some
effort into keeping BMUG running for
the enjoyment of all members?
Remember, many hands make light
work as the saying goes.

Marg Boyles
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Why choose Video Converter Ultimate for Mac?
Wondershare Video Converter
Ultimate for Mac is an all-in-one media
toolkit that lets you convert video & audio to any
popular format with 30X faster speed and zero
quality loss, transform any DVD disc to nearly any
format you want, burn DVDs and edit video etc.
Now it supports native codecs like Apple
Intermediate Codec, ProRes and DNxHD to convert
video to one optimised format for iMovie or FCP
etc. Do it all in one place and do it easier and
faster.

Features include:

Native Codec Support for iMovie,
Final Cut Pro and more

Convert and burn DVDs

Edit and Touch Up Your Videos
Convert Video & Audio to 76
Formats

Converts Videos 30X Faster

For more information Click on the links belowhttp://www.youtube.com/watch?v=UGnvw9opvuE
http://www.wondershare.net/mac-videoconverter-ultimate/?icn=nav
12
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Introducing Prue Patterson - Our Webmaster
Prue is a long time Remote Member of our Group having
joined in July 2007.
I have asked Prue to share a few things about herself, to
help our members get to know her better. Prue offers the
following:

Computers Used:
iMac 21.5 inch, OS 10.6.8 Snow Leopard; Mac Mini 2009,
OS 10.7 - Lion; iPad2;
iPhone5. Also a PC with
Windows 7 and a Canon
Printer MP810.

BMUG History:
After joining BMUG in 2007, Prue answered the call in 2009
from the then BMUG Webmaster, Don Patrick, for any member
interested in learning about websites using iWeb to become an
Assistant Webmaster.
Prue became the Website Coordinator in 2011 and revamped
the site during 2011, still using iWeb.
In 2012, for a number of reasons, it became necessary to
change our web hosting to MacHighway and to also change
from iWeb to WordPress. With the help of BMUG Editor Peter
Baldwin, the new website became operational in late 2012. It is
still a work in progress and Prue would love to receive offers of
assistance from members eager to learn about websites.

Welcome to the March edition of
our Newsletter.
Our New Year has started off
enthusiastically with a lot of interest
being shown by members for the
proposed new SIG Groups.
Unfortunately, we still have not had
any members come forward and
volunteer to assist existing Committee
Members who will be retiring at the
end of this Committee Year.
Please give this matter your earnest
consideration.
Many people I have met do not have
backups of their data. With so many
pictures, movies, music and iMovie
projects, this collection represents a
large investment in money and time.
Many who have backups do not realise
that at sometime in the recent past
their backup may have stopped
running (for whatever reason).
As more and more of the services we
use and data we store resides in the
Cloud, perhaps this will become less
of an issue, but it is going to take
some time until backing up 3TB to the
Cloud
becomes
practical
and
economical.
Unless you don’t care about losing
your data, please make 2013 the year

you start backing up your devices
properly. If you already do, please
check periodically to make sure that it
is still working on a regular basis and
that it is viable.

Use iCloud to Interact with All
Your Mountain Lion Devices
Mountain Lion is the first version of OS
X that takes advantage of iCloud,
Apple's free service for syncing and
sharing data among all your devices.
More than just a nifty service to
shuttle your contacts and calendar
items around, iCloud is turning into an
indispensable way to interact with
these various computing devices.
Being able to edit a document on your
Mac and instantly switch to editing it
on an iPad or iPhone with all changes
intact will make you wonder how we
put up with moving data across cables
for so long.

Video Converter Ultimate for Mac
This App, described on page 12 is
currently available on the website for
$69.00. I plan to demonstrate its
capabilities later in the year, at which
time a discount purchase price will be
available to members.

Peter Baldwin
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THE BMUG ASSIST PROGRAM

BOOKS AVAILABLE

This

TO MEMBERS AT

program is still available to all members. We will attempt to
resolve your urgent Mac problems if we can, or alternatively give you
advice about where to seek further assistance.

Peter Oakley is available to take your call on 0409 094 655.

HUGE DISCOUNTS

Margaret Evans is available to advise members new to Macs. Email
Margaret with your query and include your Telephone Number.
margaretevans@bellarinemac.org.au

Alternatively

you could make a booking for assistance by using the
Form on the website or by contacting Peter Oakley using the email link.
Make a Booking with Peter Oakley...

Committee Members (Pink Tags) are available during the Coffee Break
for assistance.

For enquiries re discounted books now available
for purchase or future book orders contactEmail Peter....
Alternatively, talk to Peter Baldwin at the
Meeting.

In many cases you may find a solution to your problem by inserting
your question in Google. It is amazing what information you will find.

14

